CXP6000 Color Server Software
Version 3.0 for the Xerox DocuColor
2045/2060/6060

Date: 15 April, 2003
Creo Part Number: 653-00483A
# Table of Content

**Software Kit** ................................................................................................................................................. 5

**New Features** .................................................................................................................................................. 6

- PDF 1.4 ................................................................................................................................................................. 6
- Tiff RGB ............................................................................................................................................................ 6
- JPEG .................................................................................................................................................................... 6
- Hot Folder .......................................................................................................................................................... 6
- Run Job Immediately ............................................................................................................................................. 7
- Export as InSite Job .............................................................................................................................................. 7
- Paper Sets ........................................................................................................................................................... 7
- Changes in the Finishing Tab ............................................................................................................................ 9
- Page Exceptions Enhancements ........................................................................................................................ 9
- Settings exceptions for imposed jobs .................................................................................................................. 9
- Tabs Printing ....................................................................................................................................................... 10
- Dynamic Page Exceptions Support .................................................................................................................. 11
- Remote Admin .................................................................................................................................................... 12
- Web Viewer .......................................................................................................................................................... 13
- Device Link- Enhanced Emulation Method ....................................................................................................... 13
- Emulate RGB elements ...................................................................................................................................... 13
- RGB Workflow Enhancement ............................................................................................................................ 13
- Profile Manager ............................................................................................................................................... 14
- Emulate Paper Tint .......................................................................................................................................... 15
- HKS and Pantone 2000 Spot Colors Support .................................................................................................... 15
- Spot Colors ..................................................................................................................................................... 15
- DTP 34 new firmware- upgrade ....................................................................................................................... 15
- Color Conversion Tables ................................................................................................................................ 15
- Image Noise ..................................................................................................................................................... 16
- Split to booklets ............................................................................................................................................... 16
- Slip Sheet After x Copies ................................................................................................................................ 16
- Enhanced Print Range .................................................................................................................................... 16
- Rotate 180........................................................................................................................................................ 17
- Job Preview & Editor Enhancements – Imposed Sheet View ........................................................................... 17
- New Imposition Templates ............................................................................................................................... 17
- Enhanced Preflight Report ............................................................................................................................... 18
- Print Queue Manager ...................................................................................................................................... 18
- PPD in 7 Languages ....................................................................................................................................... 18
- WinZip® .......................................................................................................................................................... 18
- Novell Client Installation ................................................................................................................................. 19
Spire Printing Over TCP/IP from MAC

CXP6000 Color Server Tips

Antivirus software
Loading Software
Add printers on client workstations
DCS Format Support
Driver and Application Collation Options
Printing on Coated Paper
Revert the system values for the Normal/saturated calibration tables
File Name
Embedded ICC Profiles
CMYK Emulation
Range printing with HCSS
Font Substitution
Staple Feature Options
Novell Banner Page
Image size to trim size ratio in Imposition
Fit To Sheet Size in Imposition
OS Set Up and Software Requirements
Job Editor
Image Scale
Admin Page
Text/Line Quality
Print Grays Using K Toner
Thumbnail View
System Disk C
LPR Printing
Calibration
Imposition S&R 5X2
Creo Spot Colors XT v2.3.1
OPI
12x18 Printable area
Backup & Restore Configuration

Variable Information (VI)

VPS Process
PPML Preview
VIPP 4.0
Printing Retrieved VIPP jobs
VI Job Thumbnails
File Naming Convention

Page 3 of 28
Creo is a world leader in solutions for the graphic arts industry. Core product lines include image capture systems; inkjet proofers; thermal imaging devices for films, plates and proofs; professional color and copydot scanning systems; creative workflow; and workflow management software. Creo is also an Original Equipment Manufacture supplier of on-press imaging technology, components for digital presses, and color servers for high-speed, print-on-demand digital printers. Creo trades on NASDAQ (CREO) and the TSE (CRE).

Note: This document contains information about the CXP6000 Color Server v3.0. Distribute a copy of this Release Notes document to all users and have the user read this document before using the CXP6000 Color Server.
Software Kit

The Software Kit includes 4 CDs (CD #1, CD #2A, CD #2B, and CD #3) with the following content:

**CD # 1: for the DocuColor 6060 and DocuColor 2000 Series**
This CD contains the Windows 2000 Professional operating system with a customized menu for reinstalling the CXP6000 Color Server.

**Note:** This version is enclosed with Internet Explorer 6.0 and Service Pack 3.0

**CD # 2A: for the DocuColor 6060**
This CD contains the CXP6000 Multilingual Application Software (Setup, PPD's, printer drivers and utilities).

**CD # 2B: for the DocuColor 2000 Series**
This CD contains the CXP6000 Multilingual Application Software (Setup, PPD's, printer drivers and utilities).

**CD # 3: for the DocuColor 6060 and DocuColor 2000 Series**
This CD contains the Utilities, the *CXP6000 Installation Guide* and the *Printing Guide*, and the customer Release Notes in PDF format in the following languages: English, French, German, Spanish, Italian, Portuguese and Dutch.

The CD has both Macintosh and PC partitions so that it can be mounted on both platforms. The Installation Guide and Printing Guide can be inserted on any client computer with a CD-ROM drive and submitted for printing on any printer. They can also be submitted to print via the CXP6000 Color Server and printed on the DocuColor 2060/6060.

**To print the CXP6000 Installation Guide and Printing Guide on a DocuColor 2045/2060/6060 using the CXP6000:**

1. Insert the *CXP6000 Color Server Documentation and Utilities* CD #3 into the CXP6000 CD-ROM drive while the CXP6000 application workspace is open.
2. From the *File* menu, select *Import Job*.
3. Browse to the CD-ROM and select the required document.
4. Click *Add to List*.
   The file appears on the right side of the *Import Job* dialog box.
5. Click *Submit*.
   The selected document is submitted to the CXP6000 Color Server to be printed.
New Features

PDF 1.4

PDF 1.4 (from Adobe Acrobat Distiller 5.0) is fully supported with this version.

Tiff RGB

Tiff RGB file format is fully supported in this version.

JPEG

JPEG file format is supported in this version (Progressive Jpeg is not supported).

Hot Folder

Use this new feature to automatically create a hot folder in the CXP6000 Color Server D:\Hot Folders folder for every published virtual printer that is defined on a client workstation. Each Hot Folder carries the virtual printer's name (HF_printer's name).

Use the hot folder to submit jobs to the CXP6000 Color Server, by connecting from a client workstation to the CXP6000 Color Server over the network. When a connection is established, drag and drop jobs onto the required Hot Folder (according to the selected workflow). Jobs that reside in the hot folder will automatically be submitted to the CXP6000 Color Server through the corresponding virtual printer.

The hot folder icon can be dragged to the desktop to create a shortcut to the folder for future usage.

As soon as the job has been spooled to the CXP6000 Color Server, it disappears from the hot folder and enters the CXP6000 Color Server In Process queue or Storage Folder, according to the selected workflow.

Hot Folder File Formats

Hot folders may contain all the files formats that are supported by the CXP6000 Color Server: PS, PDF, EPS, PRN, VPS, VIPP, PPML, JPEG, Brisque jobs, TIFF and TIFF/IT, TIFF RGB and Creo CT/LW files.

Files with unsupported formats that are moved to a hot folder, will not be imported to the CXP6000 Color Server and will remain in the hot folder.

To print a job through a hot folder:

1. Browse the network to the required CXP6000 Color Server.
2. Drag the job the user would like to print to the required hot folder icon.

Note: In windows 98 the printer name must be less than 9 characters; otherwise the Hot Folder name/icon is not displayed. For this reason the Spire default printers ProcessPrint, SpoolStore, ProcessStore hot folders are not displayed. You may save these virtual printers under a shorter name and use their corresponding hot folders instead.
Run Job Immediately

This feature enables the user to select a job in the Storage Folder, or in one of the Queue Manager queues and process / print it with top priority. If the Rush job requires processing while another job is being processed, the currently processed job will preserve its Running job status, but its processing will be paused, while the Rush job takes priority and is processed. After the Rush job has finished processing and is moved to the In Print queue, the paused job continues its processing. If the Rush job enters the In Print queue while another job is being printed, the currently printing job will preserve its Running job status, but its printing will be paused, while the Rush job takes priority and is printed. After the rush job has finished printing, the paused job will automatically continue printing.

To submit a job with top priority (as a rush job):

- Right-click the job in the Queue Manager or Storage Folder, and select the Run Immediately option.

Notes: The currently running job will finish printing the current page (both sides), or current set (depending on stapling options).

The user can only assign one job at a time as rush jobs. If the user selects several jobs (one after the other) as rush jobs, they will be processed / printed in the order of their selection.

Export as InSite Job

Creo Synapse InSite™ provides an Internet-based communication between you and your customers and streamlines the process of remote submission on-line collaboration, and remote proofing or approval. Synapse InSite is an Internet portal into the Brisque™ and Prinergy® prepress environments. If your site includes a Creo Synapse InSite™ server, exporting your job as InSite from the CXP6000 Color Server, allows you to upload and download jobs, proof online with geographically dispersed users simultaneously, append annotations or comments, and approve or reject pages over the World Wide Web using a standard browser. After the RTP job is created on the CXP6000 Color Server, it can be exported as InSite from the Storage Folder.

To export as InSite Job:

1. Select the required job in the CXP6000 Color Server Storage Folder.
2. Right-click the job and from the menu, select Export as InSite.
3. Browse to required folder.
4. Files may be uploaded from the above selected location to the Synapse InSite™ server.

Paper Sets

Use this new feature to predefine all paper stock properties in sets. Each paper set includes the following properties: size, type weight coating and color. Upon selection of such a set, which already contains all paper stock information, the user is not required to select any additional paper stock settings. In the Job Parameters window either select each parameter separately or select a defined paper set.

Managing Paper Sets

Use this new feature to add, modify or remove paper sets according to your requirements.
To define new paper sets:

1. In the **Tools** menu, select the **Paper Set** option
   Or:
   Go to any paper related parameter in the Job Parameters window and click the **Select** button.
   The Paper Set window appears.

2. Click the **Add** button.
   The Paper Set Properties window appears.

3. In the **Name** box, type a name for the new paper set. It is recommended that the name is as descriptive as possible. For example: Letter 90gsm uncoated.
4. From the **Size**, **Color**, **Weight**, **Coat** and **Type** lists, select the required properties for the new paper set.
5. Click **OK**.
6. Click **OK** in the Paper Set window.

To modify a paper set:

1. In the **Paper Sets** window, select the desired paper set to modify.
2. Click the **Modify** button.
   The Paper Set Properties window appears.
3. Modify the required properties of the paper set.
4. Click **OK**.
5. Click **OK** in the Paper Set window.

To remove a paper set:

1. Click the **Select** button.
   The Paper Set window appears.
2. Select the paper set to delete.
3. Click the **Remove** button.
4. Click **OK**.

To select the required paper set in the Paper Stock tab:

From the **Name** list select the required paper set. The selected paper set properties (**Paper Size, Type, Weight** and **Coating**) are displayed in their corresponding parameters in the **Paper Stock** tab.

**Changes in the Finishing Tab**

The **Paper Stock** option in the following parameters has been changed; instead of Paper Stock select a **paper set** and a **Tray**. See the following example with the **Front Cover** parameter.

- Admin Page
- Slip Sheet
- Front Cover
- Back Cover

**Page Exceptions Enhancements**

In addition to assigning a different paperweight, coating and type, a different paper size can also be selected for the exceptions/inserts programming and consequently print tabs.

Under the **Paper Stock Properties** option on the **Exception** tab, select a paper set that includes paper size, weight, coating and type, and a tray (same for inserts) instead of selecting properties individually.

**Settings exceptions for imposed jobs**

This new enhancement enables the user to set page exceptions / inserts for imposed jobs. See the following specifics for each imposition method.

**Saddle Stitch and Perfect Bound**

The **Saddle Stitch** and **Perfect Bound** imposition methods enable the user to image multiple pages on a single sheet. This single sheet (that contains the multiple images) is referred to as an imposed sheet. Thus, if the selected imposition methods are **Saddle Stitch** or **Perfect Bound** the exceptions attributes refer to the imposed sheet and the exceptions are handled in the imposed sheet level and not on a page level.
Step & Repeat
For Step & Repeat imposition method, exceptions are handled on a page level (same as for non-imposed jobs).

Note: When using the Step & Repeat template with the Cut & Stack sub option, the Exceptions tab is disabled.

Paper size cannot be set as exception for imposed jobs.

In order to print front or back covers in imposed jobs, do not use the front or back cover job parameters. Instead, use the Exceptions tab in the Job Parameters window, and specify sheet number one as an exception in the job.

Tabs Printing
Printed tabs are tabs that contain printed information, for example a chapter name.
In order to include printed tabs in a job, the user needs to plan ahead while preparing the job in the DTP (Desk Top Publishing) application: a different page size should be specified for the tab pages, than the body pages in order for these to be viewed as tabs.
If the DTP application does not enable specifying different pages sizes within a job, set margins within the job pages, and locate the tab content outside the margins and the body content within the margins.
When the file is imported to the CXP6000 Color Server, select one paper size for the job, and then select a different paper set for the tabs using the Exceptions tab.
The following are two procedures for including printed tabs in a job. The first procedure should be followed if the DTP application being used supports multiple page sizes within a job (for example Microsoft Word). The second procedure should be followed if the DTP application being used does not support multiple page sizes within a job.

To print tabs if the DTP application supports multiple paper sizes in job:
1. In the DTP application: Create a document and set the page size for the document body pages, for example 8.5x11.
2. Set the page size of the tabs pages. For example: 9x12.
3. Print the file to the CXP6000 Color Server using the SpoolStore workflow.
4. Double-click the job in the Storage Folder.
5. The Job Parameters window appears.
6. In the Paper Stock tab, select a paper set, which contains the document body paper size, according to the above example, a paper size of 8.5x11 should be included in the paper set.

Note: The paper size is included in the Paper Set.

In the Exceptions tab:
1. Select a paper set which contains the tab pages size. According to the above example, a paper size of 9x12 should be included in the paper set.
2. Specify the pages number that should be printed as tabs.

To print tabs if the DTP application does not support multiple paper sizes in a job:
1. In the DTP application: Create a document and define the page size (for the entire job) as required for the tabs. For example 9x12.
2. Specify the margins for the document boundaries. For example: 8.5x11.
3. Locate the content that should be printed on the tab, outside the margins.
4. Locate the body content inside the margins.
5. Print the file to the CXP6000 Color Server using the SpoolStore workflow.
6. Double-click the job in the Storage Folder.
7. The Job Parameters window appears.
8. In the **Paper Stock** tab select a paper set which contains the document body paper size. According to the above example, a paper size of 8.5x11 should be included in the paper set.

**In the Exceptions tab:**

1. Select a paper set, which contains the required tab size. According to the above example, a paper size of 9x12 should be included in the paper set.
2. Specify the page numbers that should be printed as tabs.

**Dynamic Page Exceptions Support**

The CXP6000 version 3.0 supports Set Page Device commands embedded in PS, PDF, VIPP or VPS files that enable Dynamic Page Exceptions. To support dynamic page exceptions a virtual printer must be defined that supports dynamic page exceptions commands. In addition, a required paper set that corresponds to the set page device commands (up to 4 different paper sets for each virtual printer) must be selected.

This feature is especially useful while working with VI jobs that contain a different number of pages per booklet and therefore cannot be programmed for exceptions/inserts using the standard Page Exceptions module.

CXP6000 Color Server supports the following Adobe CPSI PS level 3.0 **Setpagedevice** commands:

- **MediaType** – paper set name
- **MediaColor** - paper set color
- **MediaWeight** - paper set weight range
- **MediaPosition** - tray number

**Note:** If a job is printed using a dynamic page exceptions virtual printer, the **Exception** and **Imposition** tabs in the job parameters window will be disabled.

To define virtual printer that supports **dynamic page exceptions** (set page device commands):

1. Select the **Support dynamic page exceptions** check box.
2. Click the **Mapping Properties** button.

![Paper Set Mapping](image)

3. For each tray, select the required paper set.
4. Click **OK**.

---

**Remote Admin**

The **Remote Admin** utility enables the system administrator to perform administration actions on the CXP6000 Color Server from a remote client workstation. While this remote connection and operation takes place, the regular operation of the CXP6000 Color Server is not affected. In order to secure the remote connection, a password should be assigned by the system administrator.

The remote admin setup process includes the following stages:

1. On the CXP6000 Color Server: The remote admin service should be enabled and a password should be assigned.
2. On the System Administrator Client workstation: The client program should be downloaded and launched.

**To enable the remote admin service and set a password:**

1. On the CXP6000 Color Server, in the Admin > Preferences folder, double-click **Remote Tools** Setup.
2. The Remote Tools Setup dialog box appears.
3. From the Remote Admin Setup area, select **Enable Remote Admin Service**.
4. In the Password box, type a password.
5. Click **OK**.

---

**Note:** This password will be used later on to connect to the Remote Admin application from the System Administrator workstation. Only one Remote Admin client can be utilized at any one time.

**To download and launch the Remote Admin Client application:**

1. From the System Administrator workstation, connect to the required CXP6000 Color Server, and from the Utilities folder copy the Remote Admin Client application, according to your computer type (PC, Macintosh). Double-click the `.exe` file.
2. When installation is complete, the Login dialog box appears.
3. From the Spire Server list, select the required CXP6000 Color Server. In Macintosh client workstations, you should select from the list or type the IP Address of the CXP6000 Color Server in the **IP Address** box. The IP Address can be obtained from the Spire Monitor window in the **Network** tab.
4. Click **OK**.

The next Login dialog box appears.
5. In the **Session Password** box, type the password you have previously created in the Remote Tools Setup dialog box.

6. Click **OK**.

7. The CXP6000 Color Server workspace appears on your screen. The user may now perform any required action.

**Web Viewer**

The Web Viewer page enables the user to view the jobs status in the CXP6000 Color Server Queues, the jobs that reside in the Storage Folder, the alerts that currently appear in the Alerts window, and the printer system information. This information is significant when printing from client workstations since it enables the user to monitor jobs in the queues and act upon the viewed information.

To connect to the web viewer from a client workstation:

1. On your desktop, click the **Internet Explorer** icon.
2. When the Internet Explorer starts, in the address field type: `http://<spire name>` (if for example the Spire station name is Spire_Color, type `http://Spire_Color`).
3. The CXP6000 Color Server Web Center is displayed.
4. Click the Spire web viewer link.
5. To connect to the Spire Web Center from a client workstation, first verify that the web connect service on the CXP6000 Color Server is enabled. This service is enabled through the Administration window, under **Preferences > Remote Tools Setup**.

**Note:** To connect to the Spire from a Macintosh client workstation, use the IP Address of the CXP6000 Color Server. The IP Address can be obtained from the DFE Monitor in the **Network** tab.

**Device Link- Enhanced Emulation Method**

A new emulation method is now available – Device Link Emulation. Using the device link emulation method, the CMYK source file is transformed directly to a printer CMYK output file. The result is higher quality and accuracy of printed files.

**Note:** Device Link emulation is the default method. To emulate CMYKs using the CSA method, change the CMYK emulation method in the Administration window under **Preferences > Emulations**.

**Emulate RGB elements**

To emulate RGB elements while using Device Link with CMYK emulation selected, and consequently achieve a unified appearance for CMYK and RGB elements within the file:

1. Go to **Preferences > Color > Emulation**.
2. Select the **Emulate RGB** check box.
3. In the CMYK Workflow parameter, select **CMYK Emulation**.

**RGB Workflow Enhancement**

In the **RGB Workflow** parameter, the following standard color space profiles were added to the **Replace with** list:

- sRGB (Hewlett-Packard and Microsoft)
- AdobeRGB
Profile Manager

The Profile Manager enables the user to import source and destination ICC profiles of various devices to the CXP6000 Color Server. The sources ICC profiles are displayed in the Emulation list in the Job Parameters window, under the CMYK Workflow parameter.

To import a source ICC profile:
1. In the Resource Manager folder, double-click Profile Manager.
2. Select the Source ICC Profile tab.
3. The predefined source ICC profiles are displayed.
4. Click the Import icon.
5. Click the Browse button, browse to the source profile location and select it. The ICC profile name appears in the new emulation name text field. If the user would like to change the name, the user may do so.
6. Click the Import button to start the import process. A progress indicator is displayed.
7. When the import process is completed, a message appears.
8. Click Close.

To import a destination ICC profile:
1. In the Resource Manager folder, double-click Profile Manager.
2. Select the Destination ICC Profile tab. The system predefined, DC 6060_DC2000_GA, ICC destination profile is displayed.
3. Click the Import icon.
4. Click the Browse button, browse to the source profile location and select it. The new emulation name is displayed in the Emulation name box; if the user would like to change the name, the user may do so.
5. Click the Import button.
6. Click Close.
7. If the user would like to set the imported destination as the default, select it and click the Make Default button.

To map ICC profiles to specific paper colors:
1. Click the Mapping button.
2. The Media Color Mapping window appears.
3. For each paper color select the required profile.
4. Click OK.
5. Click Close also in the Profile Manager window.
6. The new destination ICC profile is added to the Destination ICC Profile list.

Notes:
The default profile for each color is white. The user may also add and remove custom paper colors.

The Mapping feature doesn’t function well in this version, meaning that Destination profiles that are assigned to a specific paper colors does not affect print results.
**Emulate Paper Tint**

The user can now emulate the color output to adjust white point value of the used paper stock. For example, to simulate pink paper stock while using white paper stock, the user may use the corresponding emulation profile and select the paper tint check box, the result will be that in addition to the job emulation, the paper tint will be also emulated and will have a pink shade.

**To emulate the paper tint:**
1. Go to: *Color Tab > CMYK Workflow*.
2. Select the *Emulation paper tint* check box.

**Notes:**
The *Emulation paper tint* check box is enabled only if the user selects the *Device Link Emulation* profile. When the *Emulation paper tint check box* is selected, the rendering intent that will be used is *Absolute Colorimetric*. If the job is simplex, only the front side will be printed using the tint emulation.

**HKS and Pantone 2000 Spot Colors Support**

The Spire Spot Color Dictionary for this version includes CMYK equivalents also for HKS (HKS E, N, K, Z) and Pantone 2000 (Pantone C, U, M) spot color libraries. The CXP6000 Color Server automatically matches these spot colors with their CMYK equivalents. The user may also edit the default CMYK equivalents using the Spire Spot Color Editor tool.

**Spot Colors**

Spot Colors are preserved through the whole color workflow within the system and are not affected by any of the system color adjustments tools like Gradation, Brightness Contrast.

**DTP 34 new firmware- upgrade**

In *D:\Utilities\DTP34 Upgrade* folder, there is an installer that upgrades the DTP34 Densitometer. Since the Spire application does not detect whether the DTP34 requires upgrading, it is recommended to upgrade the DTP34 if there is doubt whether it requires upgrading.

**Color Conversion Tables**

The *Color Conversion Tables* preference option enables the user to revert back to the color tables used in the previous version.

**To select the previous version set of color conversion tables:**
1. In the *Preferences* folder, double-click *Color* to expand the folder, and then double-click *Color Conversion Tables*. The Color Conversion Tables window appears.
2. By default the current version color tables are selected. To apply the previous version color tables, select *Previous version color tables*.
3. Click *OK*.

**Note:** The *In Process* queue needs to be closed while changing the color tables set.

It is recommended to restart the application in order the new setting will affect also spot colors.
Image Noise

The Image Noise parameter, located in the Print Quality tab, can be used to smoothen and blend vignettes while printing CT images. The available noise levels are between 2-10. By default, the Image Noise parameter is disabled. The user may enable it and set the required noise level. The higher the level, the smoother the vignettes appear.

To Set Image Noise:

1. Go to: Print Quality Tab > Image Noise.
2. There are two options:
   - No (default)
   - Yes.

If the user selected Yes, the user may change the Noise level from 6 to any required level. The default value when Yes is selected is 6.

Split to booklets

The Split to booklets parameter enables the user to split a PostScript file (PS or PDF files) into booklets, and simulate the VI job structure. This feature is especially useful with PostScript jobs that contain variable information. In this case, the user will be able to manage jobs more efficiently by setting the imposition per booklet, the stapling options per booklet, or use duplex printing per booklet, which will automatically insert blank pages if the number of pages per booklet is an odd number.

To split a job to booklets:

1. Go to: Job Parameters > Services tab.
2. From the Split to booklets option, select Yes.
3. In the Numbers of pages in a booklet box, type the required number of pages per booklet.

Note: If the specified number of pages per booklet is not sufficient to produce complete booklets that each contain the same specified number (there is a remainder of pages), then the last pages will form the last booklet and will consequently contain less pages than specified.

Slip Sheet After x Copies

The user may specify whether to print Slip Sheets after every copy or after few copies of the job.

To print slip sheet:

1. Go to: Job Parameters window > Finishing tab.
2. Select Print Slip-sheet.
3. Specify the required number of copies after which a slip-sheet should be printed.

Enhanced Print Range

The following options were added to the print range parameters:

- Select Odd Pages to print all odd pages.
- Select Even Pages to print all even pages.

Note: For imposed jobs, instead of typing the required pages, the user should type the required imposed sheets.

For VI files, when using Imposition Step & Repeat template with the Cut & Stack sub option, the print range option is disabled.
**Rotate 180**

The rotate 180 parameter enables the user to rotate the pages of a job in 180 degree. This option may be used while printing to various DFA devices.

**To rotate job pages 180 degrees:**
1. In the Print Settings tab, select Rotate 180.
2. From the Rotate 180 options, select Yes.

**Job Preview & Editor Enhancements – Imposed Sheet View**

The Impose sheets tab in the Job Preview and Editor window enables the user to view the imposed sheet:
- Pages appear as a printer's spread (which is known as an imposed sheet); that is, they appear in the order in which they are printed as an imposed job.
- To edit imposed jobs, use the Thumbnails or Booklets tabs, and then return to the Impose sheets tab to view the updated imposed layout.
- To view the job imposition details, click the Show info button. A pop-up window appears displaying the imposition parameters such as the sheet size, trim size, imposition template/method, margins, gutters and spine trim size.

**Note:** The Impose sheets tab is available only for imposed RTP jobs.
- In case of a duplex job, each sheet is displayed twice, once for Side A, and once for Side B. For example: Sheet 1 Side A.

**New Imposition Templates**

The following templates were added to the system predefined imposition templates:
- Step & Repeat 1X2 North South
- Step & Repeat 2X1 North South

These Step & Repeat templates locate the pages 180 degrees rotated to each other on the same sheet, and create a layout that allows the user to cut, turn and collate the printouts, so that the cut side is the same for all images:
In addition, the following layouts are now available with the Step & Repeat method templates:

- Simplex
- Simplex Rotated
- Duplex HTH
- Duplex HTH Rotated
- Duplex HTT
- Duplex HTT Rotated

**Enhanced Preflight Report**

An enhanced Preflight Report is generated in the job parameters window when a user specifies a preflight check to occur prior to the processing of a job.

**To view the preflight report:**

Right-click the job in the Storage Folder and from the menu, select **Preflight Report**. The Preflight report is displayed (if the High Res option is selected in the preflight check, the high resolution report is displayed first).

**Note:** The Preflight report always reflects the last preflight run: if more than one preflight check is run on a job, the latest Preflight report overrides the previous. In any case, when a Preflight report is produced, the date and time of the preflight check are indicated in the Job's History window.

**Print Queue Manager**

The **Print Queue Manager** enables the user to define the In Print queue policies. The user may select to enable or disable job batching as well as specify whether held (frozen) jobs will be bypassed in the In Print queue.

**To set the In Print queue policies:**

1. In the Administration window double-click the Preferences folder and then double-click **Print Queue Manager**.
2. There are two options:
   - Job Batching Policy: Enable / Disable Job Batching
   - Held Jobs Policy: Bypass / Do not bypass held jobs

**PPD in 7 Languages**

The printer PPD features are translated into the CXP6000 Color Server selected language. If for example, the language that is selected on the Spire server is Italian, the CXP6000 Color Server printer, which will be added to the client workstations, will have a PPD in Italian.

**Note:** Spire printers that were installed on client workstations prior to a language change on the CXP6000 Color Server will still present the English PPD.

**WinZip®**

WinZip® the archive utility for Windows is installed automatically with the CXP6000 Color Server to enable the zipping and unzipping of files on the desktop.
**Novell Client Installation**

To install a Novell client on the CXP6000 Color Server:

1. Close the Spire application.
2. On the Windows desktop, click **Start** and follow the path, **CXP6000 > CXP6000 Tools > Novell Client Installation**.
   The following window appears:

3. Click **Install**.
   The following window appears:

4. Click the **Reboot** button.
   The user has completed installing the Novell Client for Spire. For further information regarding configuring Novell Client for Spire see the *CXP6000 Installation Guide*.

**Spire Printing Over TCP/IP from MAC**

The Spire Over TCP/IP connection enables Macintosh clients to print jobs to SPIRE over a TCP/IP protocol. This connection enables a significantly higher spooling speed.

To set up TCP/IP printing from Mac download the Choose Spire Over IP installer from the CXP6000 Color Server **D:\Utilities** folder. For more information see the *CXP6000 Color Server Installation Guide*.

---

**Note:** To enable the Spire Over TCP/IP connection, a Macintosh O/S version 8.6 or higher, with an installed LaserWriter application version 8.6 or higher, or AdobePS 8.8 or higher is required. If the user does not have a compatible LaserWriter application installed, the user may download this application from the CXP6000 Color Server, under **D:\Utilities\Mac utilities** folder.
CXP6000 Color Server Tips

Antivirus software

The CXP6000 Color Server was tested successfully with the McAfee Virus Scan v4.5 - for Windows 2000 professional server, Antivirus Software. To limit degradation of performance, it is recommended to avoid auto scan mode and to activate the Anti Virus software only when the CXP6000 Color Server application is closed. Before installing the CXP6000 make sure all other applications are closed including Anti-virus applications. This application must be provided by the customer.

Loading Software

Do not load unauthorized software onto the CXP6000 Color Server system with the exception of the Anti-Virus software that protects the software.

Add printers on client workstations

It is recommended to use Adobe PS Driver utility from CD #3 for install printers on client workstations.

Note: When updating or installing a new version, the old printers must be removed from the client workstation and new printers installed.

DCS Format Support

The CXP6000 can process input files with embedded DCS1 or DCS2 (PhotoShop) format files.

DCS Printing Steps:

1. Place the DCS file in a DTP (Desk Top Publishing) application such as QuarkXPress or Freehand.
2. Copy the DCS file to the CXP6000 Color Server High-Resolution folder (at D:\Shared\High Res).
3. Set the PS Overprint option in the Print Quality Tab in Job Parameters or in PPD to Yes.
4. Print the file in composite mode.

Note: A different path can be used for the high-resolution DCS files. When doing so make sure the path is added to the APR search paths (Services Tab of the Job Ticket).

Driver and Application Collation Options

Most printer drivers and MS Office applications support a Collate option. To receive properly collated or stapled output, disable the Collate feature in the print driver and in the application and enable the Collate feature in the PPD.

Printing on Coated Paper

When printing on coated paper, it is recommended to select the Saturated calibration table.
Revert the system values for the Normal/saturated calibration tables

If the Normal or saturated calibration tables were edited and you wish to revert to the system default calibration table, do the following:

1. From the Tools Menu select Calibration.
   The calibration window appears
2. From the calibration table name, select SpireNormal (or Spire Saturated calibration table).
3. Click the Edit button.
   The Edit Calibration Window appears.
4. Click the Save As button.
   The Save As dialog box appears.
5. In the file name text field type Normal (or saturated).
6. Click OK.
   The following message appears:
   “Calibration table already exists, do you want to replace it”?
7. Click Yes.

File Name

If the word "executive" is used in the file name, this may result in failure in the RIP process.

Embedded ICC Profiles

Adobe and the CXP6000 Color Server support PS color management (CSAs and CRDs mechanism). Color space array is pulled out from the ICC profile (only when PS color management is the selected parameter.) and interacts with the color-rendering dictionary of the printer (CRD).

CMYK Emulation

The ICC profile names should not contain any spaces or the improper characters. Examples of improper characters include the following symbols: ! @ # $ % ^ & * ( ) - / ? > < ' " ; : \] [ { } \n
Range printing with HCSS

In duplex printing, use only continuous range printing, not non-continuous page printing, which requires a comma.

Font Substitution

In case when the DFE fails to substitute fonts and no fonts printed in the output, turn Font Substitution Off in the virtual printer.
Go to: Admin > Resource Manager > Virtual Printer
Staple Feature Options

A file with "Landscape" image orientation also has portrait staple options available, and likewise a file with "Portrait" image orientation will have Landscape options available. Choose the correct Staple orientation option according to its job image orientation. The image might be cropped when choosing a staple orientation different from the image orientation set by the application.

If a file that is sent from a client workstation with stapling and admin page selected in the PPD fails to print, open the job parameters window and re-select the required stapling option and submit the job.

Novell Banner Page

Banner page for Novell is not supported.

Image size to trim size ratio in Imposition

The ratio between image size and trim size in imposition setting should not be more than 3.0, otherwise job might fail in print. For example: do not place two Tabloid size images, trimmed to Letter size on a Tabloid size sheet.

Fit To Sheet Size in Imposition

The Fit to Sheet Size in Imposition cannot be operated with PDF Optimization. If the Fit To Sheet Size option is selected in Imposition, the PDF Optimization will be disabled by default.

OS Set Up and Software Requirements

The supported Macintosh OS is 8.51 and higher. The recommended print driver depends on the Macintosh OS that is being used. Unknown problems may occur if other drivers are used.

MAC OS 8.51-8.xx LaserWriter 8.6.1
MAC OS 9.0-9.x LaserWriter 8.7
Adobe PostScript Driver for Win NT/2000/XP is 5.2.1 and Win 98/ME is 4.5.1.

Note: The CXP6000 does not require any driver installation for MAC OS 10.x. To print to the CXP6000 from MAC OS 10.x use the Print Center application Add Printer to add the virtual printer.

Win NT/2000 clients may require login to the CXP6000 Color Server printers upon client reboot or when login as a different user. The default login name is “operator” and the password is “spire”.

Job Editor

In merged jobs created in the Preview/Job Editor, job parameters that would require a re-RIP (For example: Color Emulation, Orientation Change, Image Quality and Imposition Templates) cannot be changed.

Image Scale

The Image Scale feature cannot be operated with the PDF Optimization function. Selecting the Image Scale feature automatically disables the PDF optimization function.
Admin Page

The Color Server Name field on the Admin Page will print with the color server name from the Macintosh client workstations and the client workstation name from PC client workstations. The Sender Name field from the Macintosh OS 9.X clients will print with the Owner name. From OS X, the User Name will print in this field. Imposition using Fit to Page with Admin Page causes the Admin page image scaling to change. Admin Page is printed in English only.

Text/Line Quality

When jobs contain complicated graphic work (LW) and the Text Line Quality parameter (in the Job Parameters window) is set to High, the following message may appear: "Job <Job Name> cannot be processed with Text/Line Quality High. Change the Text/Line Quality parameter to Normal and resubmit the job".

Print Grays Using K Toner

When using this feature not only R=G=B values will be affected but also slightly different values (R+/4=B+/4=G+/4) may produce gray.

In order to have BW click charge for “Gray-CMYK Elements”:

1. In the Administration window>presences>color>emulation, select CSA emulation method.
2. Select the Print grays using K toner in the Job Parameters window.
3. Select CMYK emulation.
4. Select Perceptual or Saturated CMYK Rendering Intent in the Job Parameters window.
5. Submit the job.

Note: The Print grays Using K toner option will not affect CMYK elements when Device link emulation method is selected in the preferences.

Thumbnail View

The thumbnail view does not show the correct staple position.

System Disk C

The user should not perform any actions on the Disk C. Any procedures performed by the user such as Archiving must be performed on Disk D.

LPR Printing

All LPR commands that are related to job programming such as print method, number of copies are not supported.

Calibration

If grays colors appear "too warm" in the print output, use the gradation tool to adjust the colors and assign the new table for the specific job.
**Imposition S&R 5X2**

Crop marks are not added to a job with the following imposition setting: S&R, Portrait, 5x2 Duplex.

**Creo Spot Colors XT v2.3.1**

It is not recommended to work with Creo Spot Colors XT v2.3.1XTension when using Quark XPress.

**OPI**

When using APR on the CXP6000 Color Server make sure that the OPI XTension in Quark is not active or disable OPI Comments from the Spire preferences.

**12x18 Printable area**

To print a full print area of 12x18 you should use a 12.6"x19.2" paper size.

**Backup & Restore Configuration**

When upgrading from version 1.0 to version 3.0 the configuration can't be restored from backup. A warning message will appear in the restore window to inform the user that this can't be preformed.
Variable Information (VI)

VPS Process

It is recommended to use Creo Darwin 4.5 or higher version. In general, the DocuColor 2045/2060/6060 is capable of efficiently handling variable data jobs in segmented run lengths. Large complex jobs should always be segmented into smaller run lengths to achieve maximum throughput. The exact size of the run length varies based on the amount of variable coverage and element demographics (size and percentage of variable text vs. images/graphics). Perform regular disk maintenance to ensure trouble-free operation.

PPML Preview

Pre and post RIP preview is available for PPML jobs.

To preview PPML jobs:
1. Select PPML job in the storage folder.
2. Select Job Previ&Editor from the right click menu.

VIPP 4.0

VIPP 4.0 is fully supported with this version.

Printing Retrieved VIPP jobs

In order to print retrieved VIPP jobs the print range parameter must be deselected, otherwise the job might fail in print with the following message: “Failed Printing. Please try to resubmit the job”. After job RIPs, Print Range Booklets can be reselected.

VI Job Thumbnails

Do not attempt to view thumbnails with multi-record VI jobs, since no other job can be selected until these thumbnails have been generated on all the pages of the of the selected VI job. Do not open thumbnails for VIPP and/or VPS jobs that have been RIPed and are being held in the Storage folder, unless the user desires to view the thumbnails of the entire VI job.

File Naming Convention

Follow the naming conventions specified in the CXP6000 Printing Guide. Note that improper characters and file names with spaces may cause errors. For example: avoid using the following symbols:! @ # $ % ^ & * ( ) - / ? > < ' " ; : \ ] [ { } \ }. This is relevant for image and job files. In some cases, the CXP6000 Color Server will substitute underbars (_) in file names that contain the aforementioned characters. This will result in an inability to call out the Hi-Res image when using APR. It is recommended that all image files and the database file is scanned for these characters and fixed prior to creating any Darwin VPS file.

VPS Image Files

Supported file types utilizing the CXP6000 APR feature and the Synapse PrintXT extension includes: EPS, TIFF, and CT.

Note: General Postscript errors may result when Creo PrintXT is set to perform Image Swap on unsupported file types (that is, PDF, LZW compressed TIFF, grayscale bitmaps).
**Print Shop Mail jobs**

VI elements in Landscape orientation of Print Shop Mail jobs will be processed and printed out in Portrait orientation.
Print Shop Mail will only support EPS images.
VPS that are generated from PS Mail v4.36 for Macintosh, and v4.1 ~build 72 for PC are not imposed correctly on the Spire.

**Image Scale**

The Image Scale feature does not support VI jobs.

**Fit to Sheet Size in Imposition**

The Fit to Sheet Size feature in imposition does not support VI jobs.
Application Notes

Windows/office

Custom page sizes cannot be defined in Microsoft Word for Windows NT and 2000. The value defaults back to A3 size.

QuarkXpress

To print transparencies from QuarkXpress, first select the Page Size (A4 or Letter) in the Page Setup window and from the PPD options. Only then select the Media type: Transparency.

In order to achieve good results in imposition using quark files in Custom Size and Landscape orientation, define the paper size as follows:

- Document setup: Width = High value, Height = Low value
- Print window: Width = Low value, Height = High value
- PPD, Custom: Width = High value, Height = Low value

To ensure validity of files, check the preview window in QuarkXpress before the postscript creation.

In the printer driver window, Output tab; the only resolution option available is 300dpi, although the DocuColor 2060/6060 will print the file in 600dpi. Disregard the resolution option setting.

PageMaker

- All operating systems enable the selection of transparency with custom paper size, although the printer can only print transparencies in A4 and Letter sizes.
- All operating systems enable the selection of the custom paper size and Tray 1 or 2, although the printer can only print custom paper sizes from Tray 3 or 4.
- Custom page sizes cannot be defined in PageMaker for the Macintosh operating system. The value defaults back to Letter size. If the image is larger than Letter, it will be cropped.
- There are no error messages from the PPD when selecting the HCSS and Printer Default (Face Up) in PageMaker. Face down must be selected.
- For PageMaker files with the Landscape orientation and Duplex Mode properties, Head to Head prints as Head to Toe, and Head to Toe, prints as Head to Head.
- In PageMaker 6.5, there is no constraint from the PPD referring to "Face Down" and "collation=Yes" when choosing the stapler option.
- The Admin Page with PageMaker prints incorrectly when selecting Staple from Macintosh. The first sheet of the job will be duplicated and printed instead of the Admin Page.

Adobe Acrobat

For PS files from Adobe Acrobat (PC version) in Duplex Mode, when the Head to Head option is selected the job prints as Head to Toe.

For Adobe Acrobat files in Landscape orientation in Duplex Mode, when the Head to Head option is selected, the job prints as Head to Toe.
Illustrator v9.x and 10.x

Illustrator application functionality, such as transparent color, which is enabled through CPSI 3015, is not supported.

Freehand

Admin Page does not print with Staple Jobs from Freehand.

Adobe PS Known Limitations

The following applications do not support all Adobe PS features. Usually the application simply ignores the feature, but in rare cases, a printing error may occur.

<table>
<thead>
<tr>
<th>Application</th>
<th>Driver Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acrobat 5.05</td>
<td>Mirror Image, Negative Image, Rotated Landscape</td>
</tr>
<tr>
<td>CorelDraw 10.0</td>
<td>Scaling, Mirror Image, Negative Image</td>
</tr>
<tr>
<td>Frame Maker 5.5</td>
<td>Rotated Landscape</td>
</tr>
<tr>
<td>Freehand 9.0,10.0</td>
<td>N-up, Scaling, Landscape, Rotated Landscape, Mirror Image, Negative Image, Watermark, OpenType</td>
</tr>
<tr>
<td>Illustrator 10</td>
<td>Euro, Watermark</td>
</tr>
<tr>
<td>InDesign 2.0</td>
<td>Scaling</td>
</tr>
<tr>
<td>PageMaker 7.0</td>
<td>N-up, Scaling, Rotated Landscape, Mirror Image, Negative Image, Watermark, Euro</td>
</tr>
<tr>
<td>Photoshop 6.01</td>
<td>Watermark, Euro</td>
</tr>
<tr>
<td>QuarkXPress 4.11</td>
<td>N-Up, Rotated Landscape, Mirror Image, Watermark, Euro</td>
</tr>
</tbody>
</table>

Note: Some applications support Rotated Landscape only when it is set as the default from the Printers folder.

Workaround: Do not use these AdobePS features when printing from the above applications. Newer versions of these applications may resolve these incompatibilities.